Experiment 1
Lab Safety, ChemDraw & Excel
Reading: Handbook for Organic Chemistry Lab, section on Lab Safety (Chapter 1).

This experiment will introduce you to some tools that will serve you throughout your time in the organic
labs at CU: lab safety, plus two programs that will be used to write your lab reports. There is no prelab for
this experiment, but you can save some time by installing ChemDraw and Excel on your computer before
the lab. To do this, go to www.orgchemboulder.com/Labs/Software and follow the instructions for
acquiring and installing these programs.
Before you begin preparing for this experiment (or any other experiment in this course), you should make
sure to read the recommend sections of the Handbook for Organic Chemistry that are listed just
below the experiment’s title. These sections explain the background information and theory you will need
to know in order to understand the material, and to earn a good grade on the lab report and prelab quiz.
This particular chapter covers Lab Safety. After you finish checking in to your lab, your TA will review
and demonstrate this material, and then give you a safety quiz.
After this, you will work through the following exercises for ChemDraw and Excel; these are due in one
week from today (or two lab periods from today, during the summer). For this experiment, and for
everything you turn in during this course, you must do all the work on your own. You may discuss
the assignment with your labmates, but everything you turn in must be exclusively your own work
and nobody else’s.

Using ChemDraw to Depict Organic Molecules
ChemDraw is the chemical structure drawing program most frequently used by organic chemists. Most of
the chemical structures that you see in textbooks, journal articles, and online were created with it. The use
of ChemDraw (or another chemical structure drawing program of your choice) is also required in all of
the lab reports you will turn in for this course. Besides drawing structures, ChemDraw is also useful for
calculating the formula and molecular weight of a compound.
CU Boulder has purchased a site license for ChemDraw, so you can download it for free and install it on
your own computer – instructions are given at www.orgchemboulder.com/Labs/Software. ChemDraw is
also installed on all the computers in the organic chemistry labs and helproom; feel free to use it at any
time that the labs are open.
The following exercise is designed to introduce you to the basics of ChemDraw. The required parts are
marked with “Exercise.” For these parts, you should paste the resulting ChemDraw structure into a Word
document which you will turn in to your TA.
Open ChemDraw and choose settings: Once you have installed ChemDraw on your computer, double
click on the ChemDraw shortcut or go to the Start menu. Once the program is running, you will see a
large drawing area, a tool palette, and the menu bar. Change the settings to the ACS (American Chemical
Society) template: Under the File menu, select “Apply Document Settings from” and choose “ACS
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Document 1996”. This makes your document match the standards for the American Chemical Society.
You should use these settings for any ChemDraw images you use create in your prelabs and lab reports.

Drawing using the bond tool: Click once on the bond tool, third down on the left in the tool palette.
When you click on it, its square will lighten to show it is selected and the pointer will become a crosshair.

With the bond tool active, click and hold the mouse in the drawing area. Drag the mouse until the bond
is oriented how you want it. (You will only be able to draw a bond of a preset length; if you want to draw
a line of any length, go to the object menu and uncheck “fixed lengths”.)
Once you have one bond drawn, place the cursor on one end of that bond. A blue square will appear: this
means that you can click and drag again to build another bond onto your molecule.
To draw a double bond, with the bond tool selected, click on a single bond once to create a double bond.
Try this a few times. You can also right-click a bond and change it to a double or triple bond, or use the
double bond tool in the toolbar (right below the single bond tool).
Fixing mistakes: Made a mistake? It’s okay! Find the eraser—shaped like an eraser and third down on
the right in the tool palette. Highlight it, then click on the mistake.
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Another way to get rid of things that you do not want is to select it and hit the backspace or delete key.
To do this, click on either of the select tools in the top row of the palette and double click on a structure
or draw a box or lasso around it. When selected, a structure will have a light blue box drawn around it.
Anything selected can be moved, copied, or deleted, among other options.

You can undo an action by typing control-Z, or by going to the Edit menu and selecting Undo.
Copying into Word: Once you start drawing structures, you can paste them into Word documents. (If
you don’t have Word on your computer, you can download a copy for free. Instructions are given at
www.orgchemboulder.com/Labs/Software).
To copy your ChemDraw structure or group of structures into Word, select all of the objects and
structures you want to copy by drawing a box around them or lassoing them and copying with the copy
command under the edit pull down menu. Then go to Word and paste them where you want them. Once
a ChemDraw file is embedded in Word, you can always double-click it to edit it.
Depending on your operating system and version of Word, you might encounter compatibility issues with
inserting ChemDraw objects directly into Word. In these cases, the best workaround is to save your
ChemDraw file as an image file (the .gif, .jpg, .png, .tif, and .emf file formats should all be compatible with
Word). Once this image file is inserted into Word you will not be able to make any more changes, so be
sure to save your ChemDraw file as a .cdx file, so you can return to it later to work on it if needed.
A word of warning: not all of the computer labs on campus have ChemDraw installed. If you’re using a
computer without ChemDraw and you try to open a document that has structures copied directly into it,
the ChemDraw structures will just appear as grey rectangles. Therefore, if you’re planning on printing on
campus, then you should either save the ChemDraw structures as images before putting them into Word
or make sure you know where to find a ChemDraw-enabled computer lab (instructions are given at
www.orgchemboulder.com/Labs/Software).

Exercise 1: Draw the molecule shown here. It doesn’t have to look tidy. Paste the structure into a
new Word Document.

Drawing chains of carbons: If you need to draw a long chain of carbons, click on the carbon chain tool
(see below) and click and drag the mouse across the screen. The end of the chain will have a number after
it, indicating how many carbons you have drawn so far, but this number will disappear once you release
the cursor.
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If you hold down the mouse on the chain tool, you also have the option of drawing a freeform chain
rather than a linear chain.
Adding heteroatoms: Click on the label tool (it looks like an “A”, second column in the tool palette, 4th
down). The pointer turns to a text cursor until you are over any bonding site, then it changes to an “A”
in a box.

Click on any bonding site and type in an appropriate atom label. You can also use the text tool to click
anywhere in the drawing area and create text.

If you are using one of the selection tools, you can mouse over an atom and type the letter of a heteroatom.
(Since it’s only a single letter, there is some overlap in elements – for instance, typing a lowercase “b” will
create a bromine atom, while typing an uppercase “B” will create a boron atom.) Note that ChemDraw
will automatically add the appropriate amount of Hs to the new heteroatom.

Exercise 2: Draw the following molecule and copy it into your document.
Drawing Rings: There are several ring tools in the palette. For organic chemistry, you will probably use
the aromatic ring and the cyclohexane ring most often. To change the orientation of the ring, you can do
one of two things: either draw it, then select it, right-click it and choose Rotate from the menu; or click
and drag while you are drawing it, then release the mouse button once you reach the appropriate
orientation.

Exercise 3: Draw the structures shown above and copy them into your document.
Drawing reactions: Use the arrow tool to draw an arrow of any length. The first time you use this tool,
you might need to change the type of arrow. Do this by clicking and holding down the mouse, and then
move to highlight the arrow of your choice.
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Often a reaction will involve changing a molecule just a little. Thus, you can draw it once, then copy and
paste it to the right of the first structure, then modify the second structure.

Exercise 4: Draw the complex molecule on the left, select it, copy it, and paste it to the right move it around if necessary. Modify it to the product. Draw an arrow between the two. Copy the
final reaction into your word document.

Tidying up your structures: If your structures look messy, you can use the Clean Up Structure tool to
give them uniform bond angles and make them look professional. To do this, highlight a structure, then
go to the Structure menu and select Clean Up Structure (or type Ctrl+Shift+K by holding down the shift,
control, and K keys simultaneously). Sometimes you might need to do this multiple times, as the structure
may only get slightly neater after each iteration. In some cases, if you keep cleaning up, ChemDraw will
try to draw the molecule in a different orientation to see if that’s what you want. Remember, you can
always go back a step by selecting “undo.”
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You can also align and distribute your drawn molecules to make them look better on the page. Select the
structures that you want to work with, then go to the “Object” menu, go down to “Align”, then choose
to align left edges, right edges, L/R (left/right) centers, top edges, bottom edges, or T/B (top/bottom)
centers. The “Distribute” function is also in the Object menu; this allows you to put equal spacing between
molecules in a row.

Exercise 5: Copy the molecules you drew for Exercises 1, 2, and 3. Clean each of them up and
then put them into a horizontal row together. Align their T/B centers and distribute them
horizontally. Copy the aligned structures into your document.
Grouping objects: You can also group objects together. Once they are grouped, objects will stay in the
same position relative to each other. To do this, right-click and select Group, or type Ctrl+G. You can
ungroup them later if you need to.

Exercise 6: Draw the following reaction.

Align the L/R centers of the text and the arrow; then group them together. Then select all of the
objects for this reaction, align their T/B centers and distribute them horizontally. Copy the
reaction into your document. Notice how grouping allows the text and the arrow to remain
together, instead of getting spread out and separated.
There’s a shortcut that will allow you to do these cleanup steps automatically, if you have a starting
material, a product, and some reagents written on an arrow. Select all these components, then go to the
Structure menu and select Clean Up Reaction (or type Ctrl+Shift+X).

Exercise 7: Draw the same reaction from the previous exercise, but this time use Clean Up
Reaction to tidy it up.
Showing mechanisms: For all of the reactions you perform in this class, you will have to show
mechanisms – the movement of electrons that occurs as bonds are formed and broken. These are shown
with curved arrows. You can draw these by holding down your mouse on the arrow in the toolbar – a
menu should pop out to the right.

There are various curved arrows with various degrees of curvature. A full-headed arrow like → indicates
two electrons are moving as a pair – the most common method. A half-headed arrow like ⇀ indicates a
6

Experiment 1: Lab Safety, ChemDraw & Excel

single electron is moving alone. Often you will also have to show charges – these can be selected from
the fourth menu down from the arrows menu (it will often look like a pair of electrons by default).

Exercise 8: Draw the following mechanism.
H

Base

Br

Using templates: For some reactions in this course, the starting materials or products are difficult to
draw due to complicated three-dimensional structures. In this case, there are several preexisting templates
that will make your work a lot easier. To do this, go to the tool that looks like a rubber stamp – a menu
should pop out to the right.

Exercise 9: Draw the following reaction, using an appropriate template in the “Bicyclics” menu.

Analysis window: You can also use ChemDraw to analyze certain properties of the molecule you have
drawn, including molecular weight and formula.

Exercise 10: Draw the following molecule and select it.

Go to the “View” menu and choose “Show Analysis Window.” Click the Paste button that appears
in this new window – the properties should appear under your structure. Copy the structure and
its list of properties into your document.
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Using Excel for Data Analysis and Calculations
Excel is a Microsoft program that allows you to manipulate spreadsheets. Becoming familiar now with
Excel (or any other adequate spreadsheet program of your choice) will allow you to save time on postlab
calculations, as well as being extremely useful outside of this course. This tutorial is focused exclusively
on Excel 2016. However, if you prefer to work through this exercise in a different spreadsheet program,
you may do so, as long as you make a note at the top of the document to tell your TA which program you
are using. Instructions for accessing Excel and several other spreadsheet programs are given at
www.orgchemboulder.com/Labs/Software.
This exercise is designed to introduce you to using Excel for data analysis and calculations. The required
parts are marked with “Exercise.” For these parts, you should print the final version of the spreadsheet
and turn it in to your TA.
Open Excel and create a new blank workbook: Once you have access to Excel on your computer or
a campus computer, open up the Excel program. Create a blank workbook - this may happen automatically
in older versions of Excel. A workbook is a file type that contains one or more spreadsheets. Each
spreadsheet is a grid of cells, and each cell can contain different types of data – for example numbers, text,
or formulas. Cells are named with a column (given a letter heading) and a row (given a number heading).
In the image below, a workbook named “Excel book.xslx” is open, and it contains two spreadsheets –
“Excel tutorial” and “Other sheet”. A few cells in the “Excel tutorial” sheet are labeled with their names,
such as B2 and A4.
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Exercise 1: Open Excel and copy this data into a new spreadsheet, in the upper-left corner.
Time (min)
0
1
2
3
4
5
6
7
8
9
10

Volume (mL)
10.1
11.9
14.5
15.5
18.9
20.9
22.7
23.9
26.0
28.2
31.0

If you need to make a column wider, you can do it by double-clicking the line between column headers.
If column A is too narrow to show the entire text of “Time (min)”, double-clicking the line between “A”
and “B” will fix this.
Graphing data: A common use for Excel is for graphing data. There are many types of graph available,
but the only type that lets you treat the x-axis (time, in this case) as an independent variable is the scatter
chart. To create a chart of this data, highlight all the cells that have numbers in them, go to “Insert” in the
menu, and select scatter chart. Choose the first option that looks like disconnected data points, as shown
below. This should create a new scatter chart of your data and place it into the spreadsheet with your data.
By default, Excel will turn the first row or column of data into the x-axis (highlighted in purple), and the
second row or column into the y-axis (highlighted in blue).

Exercise 2: Create a scatter chart of the data you input for Exercise 1.
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Once it’s created, you can drag the chart out of the way so it doesn’t cover your data. You should always
label the chart itself and each axis. Click inside the chart so it’s selected. If you don’t already have labels
visible, go to “Chart Elements” (a green plus sign that appears to the right of the chart when you click the
chart) and turn on the “Chart Title” and “Axis Titles” checkboxes. You can also do this by going to the
“Chart Tool – Design” menu in the upper right, and selecting “Add Chart Element”. Double-click in each
of these text areas and rename them appropriately. The horizontal (x) axis should be labeled to match the
first column of data (time), and the vertical (y) axis should be labeled to match the second column
(volume). The chart title should normally be something like “Y-axis vs. X-axis” – in this case, “Volume
vs. Time”.
Next, you should add a trend line to your data. The exact shape of the trend line will depend on what you
are graphing, but in this case we will use a linear trend line. Go to the green plus again (or “Add Chart
Element”) and add a linear trend line. Once it’s added, you should be able to double-click it if you want
to change any of its properties.

Exercise 3: Label your chart and its axes, and add a linear trendline to your data. Drag the graph
down below your data so it’s out of the way when you do the next part.
Using Excel for Calculations: The most compelling reason to use a spreadsheet program is that it will
automatically perform a large number of calculations for you, saving you from having to do them with a
calculator. Any cell can hold a calculation based on references to other cells. To start entering an equation,
type an equals sign first. You can type directly into the cell, or you can use the white bar above the main
spreadsheet area (the formula bar – visible in the upper right corner of this image). For this data, we might
want to calculate how much the volume has changed since the initial volume, so we could set up a new
column where the volume cell has 10.1 mL (the initial volume) subtracted from it. In the first cell, C2, this
formula would be:
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If you want to put an equivalent formula into each cell, finish typing the equation and hit enter. Then
select the cell by clicking in it. It should have a box around it, with a small square in the bottom-right
corner. If you grab this box and drag downwards, you can fill all the cells in this column with a similar
formula, updated to reflect where it is. For instance, cell C4 will say “=B4-10.1” instead of “=B2-10.1”.
You can check this by clicking any of the cells that has a formula in it, and then looking at the formula
bar.

However, typing a number directly into a formula is not the best way to do things. If you end up realizing
there was a mistake, you might have to go through and replace 10.1 with the corrected number in every
single cell. Instead, you should use a formula that subtracts the initial volume from the volume at each
measurement. To do this, you’ll need to use an absolute reference, which means putting a dollar sign
before the column and row of the cell you’re referring to. So an absolute reference to cell B2 would look
like $B$2. Let’s replace all the references to 10.1 with a reference to $B$2 instead.

Again, once you’ve put this formula into one cell, you can grab the square and drag it down to fill all the
cells with an equivalent formula. Note that the reference to B2 gets changed in the other cells, but the
reference to $B$2 stays the same.
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Exercise 4: Add a column to calculate volume at any time minus the volume at time zero, as
shown above.
Now if you type a different number into cell B2, all the cells based on this will be automatically updated.
Try this now to see what happens, then undo the change by hitting the “undo” backwards arrow in the
very top of the Excel window.

You can also use absolute references to refer to constants. For instance, if the volume that you’re
measuring is of a liquid with a known density, you can calculate change in mass by multiplying density by
the change in volume. In this case, it’s done by putting the density into cell F2 and then putting an equation
that multiplies each cell by $F$2.

Exercise 5: Add a cell nearby in the spreadsheet that contains a value of 1.39 (labeled as density),
and then use this to calculate change in mass for each measurement as shown above.
Again, note that if you type a different value into the Density cell, all of the cells based on that value will
automatically update. Try this now, and then undo your change.
There are a wide range of other formulas that are available in Excel. If you click the “Formulas” tab at the
top of the page, you can view all of the options. Hovering the cursor over any of these will give you an
explanation of what it does and how to use it. We will not use these functions in this tutorial, but many
of them may prove useful in future classes.
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Formatting cells: If you want to control how the contents of a cell look, you can right-click in a cell (or
range of cells, if you have a range selected already) and select “Format Cells”. You can change the
background color, font, border, and alignment of a cell, but you can also control how a number is
displayed. For instance, if you go to the Number tab, you can choose how many decimal places are shown.

Exercise 6: Change all of the cells in the Mass column so they have two decimal places.
Ultimately your spreadsheet should look like this. Print your spreadsheet and hand it in.
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